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Abstract 

Li-Fi is the advanced technology of the world. This project is brief about the vehicle to vehicle 

communication to avoid major accidents. To enrich the mentioned feature we use the following sensors 

are listed as ultrasonic sensor, gas sensor, vibration sensor, normal robot mechanism, and Li-Fi 

Communicators. The ultrasonic sensor is used to find the distance between the vehicle in front and 

measuring the vibration level due to speed and road platform of the vehicle. The gas sensor is used to 

measuring the alcohol level of the vehicle driver and this data is sent to the nearby vehicles through the Li-

Fi communicator. Integrating Li- Fi into V2V communication systems holds great potential for improving 

road safety and traffic management. This paper delves into the key aspects of this integration, such as the 

design and implementation of Li-Fi transceivers in vehicles for enhancing the road transport, the 

development of communication protocols tailored for V2V scenarios, and the assessment of the system 

performance in dynamic and challenging vehicular ambience. The research aims to contribute valuable 

insights into the feasibility and benefits of employing Li-Fi for enhancing communication between 

vehicles, thereby paving the way for more robust and efficient intelligent transportation systems.The 

proposed description for Li-Fi (Light Fidelity) in the context of Vehicle-to-Vehicle (V2V) communication 

outlines an innovative solution that leverages visible light as a medium for seamless and high-speed data 

exchange between vehicles. This cutting-edge technology involves integrating Li-Fi transceivers into 

vehicles, enabling them to communicate through modulated light signals. Additionally, the proposal 

delves into the intricacies of designing communication protocols tailored specifically for dynamic V2V 

scenarios, ensuring optimal performance in diverse driving environments. By exploring the potential of 

Li-Fi in V2V communication, the description aims to contribute to the development of intelligent 

transportation systems that prioritize efficiency, safety, and the advancement of connected vehicle 

technologies. This proposed framework envisions a future where Li-Fi plays a pivotal role in transforming 

how vehicles communicate, fostering a new era of smart and interconnected mobility. 
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I. INTRODUCTION 
The overview of Li-Fi employing 

Vehicle-to-Vehicle (V2V) communication 

provides a comprehensive utilizing visible light 

for data transmission, presents a promising 

alternative to conventional insight into the 

intersection of Li-Fi technology and the 

automotive domain. Li-Fi, an innovative 

communication paradigm radio frequency

methods. In the context of V2V communication, 

this overview explores the potential applications 

and benefits of integrating Li-Fi into vehicular 

networks. Key considerations inc

deployment of Li-Fi transceivers within 

vehicles, the development of 

communication protocols tailored to V2V 

scenarios, and the optimization of data transfer 

rates in dynamic driving environments. The 

overview also addresses challenges such as li

of-sight requirements and the impact of ambient 

lighting conditions on Li-Fi performance. By 

presenting a holistic perspective, this overview 

aims to elucidate the transformative possibilities 

of incorporating Li-Fi into V2V communication 

systems, offering a glimpse into the future of 

intelligent and connected transportation.

Unfortunately, most counties in the world 

has an alarming record in number of 

death/disability due to tremendous number of 

accident. Accidents are occurred because of 

unawareness of the people. found that 57% of 

accidents where due to solely driver factors, 

which include his behavior, decision making 

ability, reaction speed and alertness. The studies 

the accidents can be avoided if driver was 

provided with warning message few seconds

before so that, they can take some alternative 

route or be cautious to avoid traffic congestion or 

accidents.The vehicular adhoc network was 

adopted to mimic the adhoc nature of highly 

dynamic network. In this network two vehicles 

can communicate with each other. For Vehicle 

safety a new technique can be created. VANET 

Communication is classified into two different 

types Vehicle to Vehicle communication and 

Vehicle to Infrastructure Communication. The 
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has an alarming record in number of 

death/disability due to tremendous number of 

accident. Accidents are occurred because of 

the people. found that 57% of 

accidents where due to solely driver factors, 

which include his behavior, decision making 

ability, reaction speed and alertness. The studies 

the accidents can be avoided if driver was 

provided with warning message few seconds 

before so that, they can take some alternative 

route or be cautious to avoid traffic congestion or 

accidents.The vehicular adhoc network was 

adopted to mimic the adhoc nature of highly 

dynamic network. In this network two vehicles 

h other. For Vehicle 

safety a new technique can be created. VANET 

Communication is classified into two different 

types Vehicle to Vehicle communication and 

Vehicle to Infrastructure Communication. The 

vehicle to vehicle communication is a 

communication between two vehicles (i.e.) one 

hop communication such as car to car 

communication. The vehicle to Infrastructure 

communication is communication between 

vehicle and road side Infrastructure. It acts as a 

multi hop communication. The vehicle to vehicle 

communication is a system designed to transfer 

basic safety related with vehicles to provide 

warning to drivers concerning accidents. The 

main objective of this system is to alert drivers 

when he closes to front vehicle. The 

communication between the vehicles tak

by means of LI-FI. The distance between two 

vehicles is measured using Ultrasonic sensor. 

The microcontroller controls the entire circuit 

and is programmed to notify the driver with a 

message when the vehicle comes within the Line 

of sight . There are several obstacles that hinder 

the safety while driving. The vehicle such as car 

or buses may break down in middle of the road 

especially during the night time these becomes a 

serious obstacles mainly in highways were the 

roads are not lighted. The veh

may not judge the stationary vehicle and may 

cause accident; the vehicle coming behind may 

hit hardly to the back of stationary vehicle and 

may lead to greater damage. Many scenarios 

were considered for the design of the system.
A.First Scenario  

Vehicle1 slows down the speedometer 

senses the speed if lower than the previous speed 

an Ultrasonic Sensor attached in the bonnet using 

Doppler-effect is made to sense continuously. 

When the distance between the two vehicles 

decreases a warning message is transferred to 

back vehicle using the transmitter attached in the 

front vehicle it is received by the photo

attached to the back vehicle so he can take 

necessary steps to ensure that collision is 

avoided. 

 

 

 

Fig1.1  First Scenario of Vehicle to Vehicle 

Communication Using VLC
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B.Second Scenario  

The major reasons for accidents are due 

to the negligence of the driver who might be 

under the influence of alcohol or might be 

sleeping while driver. The vehicles are interfaced 

with an Alcohol as well as an Eye-blink sensor to 

monitor driver. If the driver is under the 

influence of alcohol or is sleeping this 

information is transferred to vehicle within the 

line of sight so vehicle can speed up or allow the 

vehicle to go ahead without causing any damage.

Fig 1.2. Second Scenario of Vehicle to Vehicle 

Communication Using VLC

The organization of paper is as follows section 2 

provides information about the system design. 

The results and experimental setup are discussed 

in section 3. The conclusion and future scope is 

discussed in section 4. 

II.Existing System 

The study proposes the use of optical 

intelligent reflecting surfaces (O-IRS) at road 

intersections to improve safety message 

dissemination for vehicular visible light 

communication (V-VLC) systems. O

significant performance enhancements compared 

to baseline scenarios, achieving longer 

communication range and ensuring quality

service (QoS). The research also explores the use 

of millimeter wave (mmWave) bands for 

improved automated driving and data rate and 

latency requirements in automotive applications. 

The study validates the proposed mmWave path 

loss models for the NR-V2X system using link

level simulation. The study also explores AI and 

ML cyber security solutions, focusing on the 

challenges of big data collection, fast and 

efficient communication, and handling privacy in 

IoV systems. The disadvantages of existing 

systems include cost, logistical challenges, 

interference issues, interoperability issues, and 

the potential for cybersecurity incidents or 

accidents. 
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The proposed Li

system is an innovative solution for Vehicle

Vehicle (V2V) communication, leveraging 

visible light as a medium for seamless and high

speed data exchange between vehicle

cutting-edge technology integrates Li

transceivers into vehicles, enabling them to 

communicate through modulated light signals. 

The system offers potential advantages such as 

enhanced data transfer rates, reduced 

electromagnetic interference, an

security compared to traditional radio frequency

based communication systems. The system is 

designed for two vehicles, with the Vehicle 

Module (VM) embedded with the vehicle acting 

as moving nodes. It consists of various sensors, 

microcontrollers, Light emitting diodes, and 

photo diodes to retrieve data.

The system includes an ultrasonic sensor, 

alcohol sensor, and eye blink sensor. Challenges 

in designing the system include processing delay 

and line of sight limitations. Advantages of the 

proposed system include reduced 

electromagnetic interference, increased 

bandwidth efficiency, inherent security benefits, 

and high data transfer rates.

Fig 3.1 Block Diagram

The Li-Fi system consists of two parts: 

the Li-Fi transmitter and the Arduino

transmitter is connected to the Arduino board, 

while the Arduino board is connected to the Li

module. The system aims to contribute to the 

development of intelligent transportation systems 

that prioritize efficiency, safety, and the 

advancement of connected vehicle technologies.

 

III.SOFTWARE DESCRIPTION

Arduino IDE is an open

platform designed to make it easy for users, 

particularly those with little to no programming 

experience, to program and develop projects 

using Arduino microcontroller boards. The IDE 
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platform designed to make it easy for users, 
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experience, to program and develop projects 
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features a user-friendly graphical interface, a 

code editor with syntax highlighting and auto

completion, and a message area for writing and 

editing code. Arduino boards can read inputs and 

turn them into outputs using the 

programming language (based on Wiring) and 

the Arduino Software (IDE), based on 

Processing. 

Arduino was born at the Ivrea Interaction 

Design Institute as an easy tool for fast 

prototyping, aimed at students without a 

background in electronics and p

Over the years, Arduino has been the brain of 

thousands of projects, from everyday objects to 

complex scientific instruments. A worldwide 

community of makers has gathered around this 

open-source platform, contributing to an 

incredible amount of accessible knowledge that 

can be of great help to novices and experts alike.

 

 

 

 

 

 

 

 

 

 

 

 

Arduino IDE 
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Over the years, Arduino has been the brain of 

thousands of projects, from everyday objects to 

complex scientific instruments. A worldwide 

community of makers has gathered around this 

source platform, contributing to an 

accessible knowledge that 

can be of great help to novices and experts alike. 

The Arduino IDE is relatively 

inexpensive compared to other microcontroller 

platforms, running on Windows, Macintosh 

OSX, and Linux operating systems. It is a 

simple, clear programming environment, open 

source and extensible software, and published 

under a Creative Commons license, allowing 

experienced circuit designers to make their own 

versions of the modules and extend them.

 

Programs written using Arduino 

Software (IDE) are called sketches, which are 

saved with the file extension.ino. The IDE uses 

the concept of a sketchbook, a standard place to 

store your programs or sketches. Sketches can 

be opened from the File > Sketchbook menu or 

from the Open button on the toolbar.

 

Tabs, multiple files, and compilation 

allow you to manage sketches with more than 

one file, including normal Arduino code files, C 

files, C++ files, or header files.

To upload a sketch to an Arduino Nano, select 

the correct items from the Tools >Board and 

Tools > Port menus. The boards are described 

below: 

 

 

 

 

 

ARDUINO NANO INTERFACE

For Mac, the serial port is usually 

/dev/tty.usbmodem241 (for an Uno or Mega2560 

or Leonardo), /dev/tty.usbserial

Duemilanove or earlier USB board), or 

/dev/tty.USA19QW1b1P1.1 (for a serial board 

connected with a Keyspan USB

adapter). On Windows, it's probably COM1 or 

COM2 (for a serial board) or COM4, COM5, 

COM7, or higher (for a USB board). On Linux, it 
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or Leonardo), /dev/tty.usbserial-1B1 (for a 

Duemilanove or earlier USB board), or 
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should be /dev/ttyACMx, /dev/ttyUSBx or 

similar. 

When uploading a sketch, you're using 

the Arduinobootloader, a small program that 

allows you to upload code without using any 

additional hardware. Libraries provide extra 

functionality for use in sketches, such as working 

with hardware or manipulating data. To use a 

library in a sketch, select it from the Sketch > 

Import Library menu. 

 

 

 

 

 

 

 

 

NANO INTERFACING USB TYPES OF PORT

Third-party hardware can be added to the 

hardware directory of your sketchbook directory. 

Platforms installed there may include board 

definitions, core libraries, bootloaders, and 

programmer definitions. To install,

hardware directory and unzip the third

platform into its own sub-directory. 

The Serial Monitor displays serial sent 

from the Arduino board over USB or serial 

connector. To send data to the board, enter text 

and click on the "send" button or press enter. 

Choose the baud rate from the drop

that matches the rate passed to Serial.begin in 

your sketch. 
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SELECT BOARD TYPE

Preferences can be set in the preferences 

dialog or in the preferences file. Board selection 

affects parameters used when compiling and 

uploading sketches and file and fuse settings 

used by the burn bootloader command. The 

Arduino Software (IDE) includes b

for the boards based on the AVR Core.

Proteus ISIS Professional is a software 

tool set designed by Labcenter Electronics Ltd. 

for creating schematics, simulating electronics 

and embedded circuits, and designing PCB 

layouts. It is used by engineering students and 

professionals to create schematics and 

simulations of various electronic circuits. Proteus 

is lenient in circuit designing and works on ideal 

conditions, ensuring that circuits work without 

garbage value. It is also used for PCB des

with Proteus ARES being used for this purpose.

 

 

 

 

Proteus ISIS

  Proteus is also used for designing 

programming codes for different 

microcontrollers, such as Arduino, PIC 

Microcontroller, and 8051. In embedded projects, 

Proteus is a relief as it allows for testing without 

burning the microcontroller multiple times for 

typographical errors. The language was initially 
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created as a multiplatform system utility for 

manipulating text and binary files and creating 

CGI scripts. It later focused on Windows, adding 

specialized functions for network and serial 

communication, database interrogation, system 

service creation, console applications, keyboard 

emulation, and ISAPI scripting (for IIS). 

 

IV.ADVANTAGES & RESULT 

A.Result 

The top view of the front vehicle and 

back vehicle is presented. The top view presents 

the various sensors interfaced with the control 

unit. The Top view of the front vehicle consists 

of a buzzer and a LCD monitor to notify the 

driver with a warning message. The 

Photodetector is used in front vehicle to receive 

the data transmitted by the LED. 

The Back vehicle consists of Ultrasonic 

sensor to measure the distance between the two 

vehicles. An sensor is used to check if the driver 

is sleeping while driving and alcohol sensor is 

interfaced with control unit to find if the driver is 

intoxicated by alcohol and use the LED to 

transmit the safety related message so that the 

front vehicle can be notified. 

B.Advantages 

The advantages of employing Li-Fi in 

Vehicle-to-Vehicle (V2V) communication are 

substantial and transformative. Firstly, Li-Fi 

offers significantly higher data transfer rates 

compared to traditional wireless communication 

technologies, enabling rapid exchange of 

information between vehicles. This increased 

speed enhances the responsiveness of V2V 

communication systems, contributing to 

improved road safety and traffic management. 

Li-Fi's reliance on visible light also mitigates 

electromagnetic interference concerns, providing 

a more stable and reliable communication 

environment for vehicles. Moreover, the 

integration of Li-Fi supports the growing demand 

for bandwidth in connected vehicles, facilitating 

the seamless transmission of data for applications 

such as real-time navigation, traffic updates, and 

multimedia streaming. Additionally, Li-Fi's 

inherent security benefits, stemming from the 

confined nature of visible light, make it a robust 

solution for protecting sensitive V2V 

communication from external interference and 

cyber threats. Overall, the advantages of Li-Fi in 

V2V communication encompass speed, 

reliability, bandwidth efficiency, and enhanced 

security, paving the way for a more efficient and 

secure future of intelligent vehicular networks. 

 

V.Conclusion 

The integration of Li-Fi technology in 

Vehicle-to-Vehicle (V2V) communication holds 

immense promise for revolutionizing the 

landscape of intelligent transportation systems. 

With its capacity for high-speed data transfer, 

reduced electromagnetic interference, and 

enhanced security, Li-Fi addresses critical 

challenges in V2V communication, contributing 

to safer and more efficient road networks. The 

advantages of rapid data exchange, minimal 

interference, and increased bandwidth efficiency 

position Li-Fi as a key enabler for real-time 

applications in connected vehicles. As the 

automotive industry continues to evolve towards 

smarter and interconnected mobility solutions, 

Li-Fi emerges as a compelling technology, 

offering a robust foundation for the future of 

V2V communication. The potential impact of Li-

Fi extends beyond mere connectivity, shaping a 

landscape where vehicles can communicate 

seamlessly, ensuring not only enhanced safety 

but also paving the way for a more efficient and 

intelligent transportation ecosystem. As research 

and development in this domain progress, Li-Fi's 

role in V2V communication represents a 

paradigm shift towards a more connected, secure, 

and technologically advanced future for 

vehicular networks. Vehicle-to-Vehicle 

Communication is easy and simple to use. With 

the proposed system warning messages can be 

transmitted at faster rates that foster drivers to 
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make strategic decision at faster rate which is 

vital in making strategic decision avoiding 

accidents and congestion. In future the project 

can be extended to communicate Vehicle-

toInfrastructure for smart city. 
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